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1.
Overview


1.1
Description

The Test Discrepancy Report (TDR) documents a problem revealed during application or Enterprise level testing.  The TDR also is the mechanism used to document whether the problem has been corrected, and if so, what was the actual origin of the problem and the affected configuration items (CIs).  

TDRs are not to be used to report enhancements or new requirements.  The Software Change Request (SCR) is the mechanism used to request enhancements to existing functionality or new requirements during Development Test and Evaluation (DT&E).

Test Discrepancy Reports are also referred to as Test Deficiency Reports (TDRs) within the Configuration Management Information System (CMIS), and the test management tool, Test Director.  The terms are used interchangeably.

1.2 Establishing the Infrastructure

Establishing the infrastructure for reporting discrepancies during a test event should be performed as part of the setup for the test, and should be completed prior to the test execution.  For each level of testing, Software Integration Test, Functional Validation Test, and all levels of the Enterprise testing, the test level and test event needs to be configured within the TDR reporting tool, CMIS.  This can only be done under the release that was established for the software development requirements analysis phase.  The release must be locked within CMIS prior to creation of the test level and test event. 

The CMIS release can only be locked by the Technical Change Coordinator (TCC) Supervisor, when all Configuration Change Orders (CCOs) for the SCRs contained within the release have been completed.  The system will prevent the locking of the release for incomplete CCOs.  It is the responsibility of the PMO to configure the CCOs.  This should be a critical exit criteria for any successful Test Readiness Reviews (TRRs).


1.3
Terminology

The standard test processes for DCII applications and Enterprise testing refer to specific terms that should be used consistently.  Unfortunately, not all tools used for testing or reporting discrepancies use the same terms.  Therefore, the following table identifies terms that are used throughout the TDR process for your convenience.

DCII Test Process Description
CMIS Terminology
Example / Description

Test Component
Test Level
SIT, FVT, EIT, EPT, EAT

Test Cycle
Test Event
A test cycle represents one complete execution of the test scripts.

Test Discrepancy Report
Test Deficiency Report


2.
Recording and Tracking
2.1 Numbering Schemes
CMIS controls the numbering scheme for TDRs within a test event.  This is accomplished automatically by a one-up numbering sequence, beginning with 001 within each event.  Since there are more than a single test component for an application release and DCII release, test directors, test managers, and testers should always refer to more than just the TDR number itself when reporting.  For example:

Example
Application
Test Level
Test Event
TDR Number

GET.SIT.002.012
GETBACC

SIT
002
012

DSDS.FVT.001.004
DSDS
FVT
001
004

DCD.EIT.004.008
DCD

EIT
004
008

DCW.EIT.002.006
DCW
EIT
002
006

2.2 TDR Tracking
TDRs will be tracked by the Test Manager until closure.  Closure may consist of canceling the TDR if not a valid discrepancy; closing the TDR once fixed and closed; or converting the TDR to an SCR.  Priority 1 and 2 TDRs will be resolved prior to the completion of any test component.  Priority 3, 4 and 5 TDRs may or may not be corrected during a test component, but must be converted to an SCR prior to completion of the test component if not corrected.  No TDRs should remain open at the conclusion of the test component, either at the application level or Enterprise test level.

3.
Roles

3.1 CMIS Roles
The SIT/FVT test manager, the TDRC, and testers each are assigned roles within CMIS.  The test manager and testers should be assigned the role of Technical Action Manager (TAM) in CMIS in the application that they are responsible for testing.  The test manager, TDRC, leads, and testers all review the TDRs during daily teleconference.

Enterprise testers should be assigned as TAMs in CMIS. This is required for initiation and routing of EIT TDRs. If Functionals are utilized to help execute a test event, they are also assigned as TAM and restrictions on TDR initiation is controlled in TD.
3.2 Role Assignments
It is the responsibility of the Test Manager to ensure that all test team members have access to the correct CMIS database for their respective applications, and have been given the correct role assignment.  Access to CMIS must be accomplished by completing the DTI/MITO user access request form, accompanied by the role assignment and TAM identification, to their respective TASO and Technical Change Coordinator (TCC) for approval and action.

The Technical Change Coordinator (TCC), Functional Change Coordinator(FCC), project development Action Managers, Project DBA Action Managers, and DCII System Integration Action Manger should be assigned role assignments are determined for the test teams.

NOTE:  DCII has not formally established the FCC role which was intended to approve and process SCRs per release.  This function is currently handled by Andy Moxley and Karen Tinsley.

In the event that a TDR identifies a difference between the design/physical implementation and the requirement, DCII procedures are in place to route the TDR to the Functional POC for the given release.  The Functional POC is responsible for creating and processing the appropriate documentation (covert TDR to SCR or write SCR Amendment) required to satisfy the TDR.
The Test Manager should contact their LAN Support Team (LST) to request/ensure that the standard CMISPB configuration is installed on their workstation or test client PC. 

4.
Application Under Test
4.1 Application Level Testing

The application under test is the only application that TDRs should be initiated against during the test execution.  Core applications of the DCD can each initiate TDRs against their own core application.  Type II and Type III applications can initiate TDRs against their respective application.  A core application, Type II application, or Type III application will not initiate TDRs against another application during SIT or FVT.

4.2 Enterprise Level Testing
Enterprise testing is unique in that it is the only time that testers may initiate TDRs against more than one application within a DCII release.  The Enterprise test is the first time that all applications are integrated within the same architecture.  TDRs that report problems with Type I application interfaces to the DCII shall be recorded within the DCD application, then forwarded on to the Type I application system manager for resolution.

5. Creating a New System Test
5.1 Accessing CMIS
The first step of setting up CMIS to initiate TDRs for a test component is getting access.  Once the TAM has an account within the appropriate CMIS database, and has been given a role assignment within CMIS, the next step is to access CMIS to start a new system test or test level.  Following are the procedures for accessing CMIS:

5.1.1
Select DFAS CMIS from the “programs” menu.  The CMISPB Login screen displays.

5.1.2 Select from the Location pick list the CMIS database location for your application.

5.1.3 Enter User ID and password, and select OK.
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            Image of CMISPB Login box, requesting Location, User ID, and Password

5.1.4 Select appropriate AIS Selection and User Assignment

[image: image9.png]|4 Microsoft Word - Copy of TDRPROCS =18l x]

[TVl Edt view Insert Fomat Took Table Window Help =18l x]
lozEaRy | iaed o --|ae

[oms o o +|m 2

Test O step 3 Expected Resul: s Evclde Regon | X2 Undo Last 12

e oot § g s S

CMIS - DCD ( Technical Action Manager ) [_[CIx]

| st

=]

Eie Y View Eocess Tods Windon Heb
Ciiz
G
Gifis
Gt
i StatTest CTRELERSE 2
Exdes.
| Fosoren = 5
B DA Chse
05 o lssure Release Status: Locked

Lovel Start Date End Date Result_# Events # TDRs

05/04/2000  00/00/0000 i
0471172000 00/00/0000 2 e
032772000 00/00/0000 1o

[Lindo, Eu, Copy, o Pase

s \ N JOHA &-L-A-==588a
[Fage 8 Sect oie [ase s Gal |[ec e R e L O ]

g Start| 2jinbox - Microsaft Ouook | 37 Mictosoft Ward - Copy of T.|[EJCMIS - DCD ( Techni Y D 140PM

s





              Image of AIS Selection and User Assignments box showing columns of

              Project, User ID, Description, and User Type

5.1.5 From the Process menu of the CMIS startup window, select Testing.
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Image of CMIS - DCD (Technical Action Manager) screen with the Process menu open and the Testing selection highlighted.
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Either enter the release number within the Release selection field, select Retrieve All Releases radio button, or just press the Enter key from the Find -System window.

Image of a desktop with CMIS - DCD (Technical Action Manager) box open, System Testing box open on top of it, and Final - System Testing box open on top.

5.1.7 The System Testing window opens.  If all releases were selected in the previous step, select the correct application release number from the pick list.
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Image of a desktop with CMIS - DCD (Technical Action Manager) box open, with the System Testing - 0200 EIT box open on top of it


5.2
Starting a New System Test
The next step in setting up a test level is starting a new system test within CMIS.  Following are the procedures for creating and starting a new test level:



5.2.1
From the File menu, select New. 
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          Image of Word (copy of TDRPROCS) open with CMIS - DCD (Technical Action Manager) box   

   open, System Testing - 0200 EIT box open on top of it, and the New System Test open 

on top.

5.2.2 Select the appropriate application/DCII release from the pick list.

5.2.3 Enter the test Level.  Valid test levels for DCD, DCW, and Type III applications are SIT or FVT.  (Type II applications may elect to have FVT instead of SQT.)  Valid test levels for Type I and other Type II applications are SIT, SQT, and SAT.  Valid test levels for Enterprise testing are EIT, EAT, and EPT.

5.2.4 Select Save.

5.2.5 From the Edit menu, select Start Test.
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 Image of Word page (copy of TDRPROCS) with CMIS - DCD (Technical Action Manager) 

 open on top of it with Edit menu opened with the Start Test selection available.
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Image of Word (copy of TDRPROCS) screen open with CMIS - DCD (Technical Action 

Manager) open on top of it, System Testing - 0200 EAT window open on top of that, 

            and the Start System Test window open on top.

5.2.6 Enter the Start Date of the test at the Start System Test window, and select Save.

5.3
Starting a Test Event
5.3.1 Select the Events tab from within the System Testing window for the new test level you just created and started.

5.3.2
Select the Add button.
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Image of Word (copy of TDRPROCS) screen open with CMIS - DCD (Technical Action     

Manager) open on top of it, System Testing window open on top of that, and the  

Add/Configure System Test Event window open on top.

5.3.3
Enter the test cycle number in the Event field.  (The first test event should be numbered 001.)

5.3.4 Enter the total number of hours for the test event within the Estimated Hours field.

5.3.5
Enter description of the test event within the Details field.  Select Save.
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Image of Word (copy of TDRPROCS) screen open with CMIS - DCD (Technical Action Manager) 

open on top of it and System Testing - 0200 EAT window open on top.

5.3.6 The new test event will be displayed after saving.

6.
 TDR Handling Procedures

6.1 Forwarding Not Fixed TDR for Action
Once a TDR has been returned, retested, and put into not fixed status in Test Director, it must be forwarded to the TDR Coordinator for action.  The following procedures describe the method for forwarding a TDR for action.

6.1.1
Select by highlighting the TDR to be forwarded.

6.1.2
From the Edit menu, select Forward TDR.
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Image of Word (copy of TDRPROCS) screen open with CMIS - DCD (Technical Action Manager) open on top of it with Edit menu pulled down showing selections of Forward TDR and TDR Closure.

6.1.3
The Forward System TDR window displays.  Select the TDR Coordinator and press the OK button.

6.1.4
A Forwarding Completed message box will display.  Press the OK button to close.
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Image of Word (copy of TDRPROCS) screen open with CMIS - DCD (Technical Action Manager) open on top of it, System Testing window open on top of that, Forward System TDR open on top of that, and Forwarding Completed box open on top.



6.1.5
By selecting the Routing tab, the initiator may view the TDR routing. 




6.2
Selection of Action Manager
The tester will route all TDRs to the TDRC. The TDRC will route TDRs by the Current Owner field in the TDR to the TAM of the application that the TDR is against.


6.3
TDR Action for Server-Side Repository Object

If the Suspected Origin of the TDR is either CM/RM, Code, Database, or Development and it has been determined during the TDR review that the problem is within a server-side object, the following steps identifies the action of the TDR:

NOTE:  CM SHOULD BE NOTIFIED AT SAME TIME AND EACH TIME THAT RELEASE MANAGEMENT IS NOTIFIED FOR CM/RM TDR CAUSES/ACTIONS.  THIS WILL ENSURE THAT THE DCII CMIS CI TABLE IS MAINTAINED AND CURRENT TO ALLOW THE IDENTIFICATION OF OBJECTS VIA CCOS AND TDRs.  
6.3.1
Project development Action Manager sends request to Release Management to open the BASELINE application for specified users and objects (CCOs). This request should include the Release Test Event desigination and TDR number.

6.3.2
Project development team makes corrections to the software based upon discrepancy identified in TDR description and provides a daily status of the TDR until it is completed to the DCII Generation Team.

6.3.3
Project development Action Manager notifies Release Management and the DCII Generation Team by email that the TDR is ready to be retested.  The resolution of the TDR is to be included in the email.

6.3.4     The DCII Generation Team documents the resolution of the TDR

within the TDR Resolution field in CMIS, and identifies the impacted CCOs.  The DCII Generation Team forwards TDR back to the test TAM.

6.3.5
Release Management removes access to BASELINE from the project development team.

6.3.6
Integration requests Release Management check out the CCOs (by file name, not module name) to the ISO outbox.

6.3.7
Release Management checks the objects out of PVCS and delivers to the ISO outbox.

6.3.8
Release Management sends email notification to Integration that objects are ready in the ISO outbox.

6.3.9
DCII Generation Team retrieves objects from the ISO outbox and deletes them from the ISO outbox.

6.3.10   DCII Generation Team regenerates the CCOs.

6.3.11    DCII Generation Team writes the readme file.  The readme file may be for more than one TDR.  Generation will only occur once daily, or as required by the Test Manager, unless the TDR is priority 1.  Generation occurs immediately upon correction of a priority 1 TDR.  The readme file will contain the following information:

· Synopsis of each TDR 

· Match between CCOs and TDRs

· PVCS only instructions (for files only going to PVCS) 

· PVCS and DBA instructions

· DBA only instructions (provides information such as schema, alters provided by development teams, etc.)

6.3.12
DCII Generation Team places all the objects and readme file into the ISO inbox.

6.3.13
DCII Generation Team notifies Release Management by email that the objects are in the ISO inbox for the specific TDRs.

6.3.14
Release Management retrieves the objects from the ISO inbox and checks them back into PVCS.

6.3.15
Release Management delivers the files to the DBAs as defined in the readme file.

6.3.16
DBAs reviews the files received.

6.3.17
DBA coordinates with the Test Manager (TAM) before installation.

6.3.18
DBAs installs the changes to the test environment.

6.4
TDR Action for Client-Side Repository Object 
If the Suspected Origin of the TDR is either CM/RM, Code or Development, and it has been determined during the TDR review that the problem is within a client-side object, the following steps identifies the action of the TDR:  

6.4.1
Project development Action Manger sends request to Release Management to open the BASELINE application for specified users and objects (CCOs). 

6.4.2     Project development team makes corrections to the software based upon  

discrepancy identified in TDR description and provides a daily status of the TDR until it is completed to the DCII Generation Team.

6.4.3
Project development Action Manager notifies Release Management and the DCII Generation Team by email that the TDR is ready to be retested. The resolution of the TDR is to be included in the email.

6.4.4     The DCII Generation Test Team documents the resolution of the TDR

within the TDR Resolution field in CMIS, and identifies the impacted CCOs.  The DCII Generation Team forwards TDR back to the test TAM.

6.4.5
Release Management removes access to BASELINE from the project development team.
6.4.6
Integration requests Release Management check out the CCOs (by file name, not module name) to the ISO outbox.

6.4.7
Release Management checks the objects out of PVCS and delivers to the ISO outbox.

6.4.8
Release Management sends email notification to Integration that objects are ready in the ISO outbox.

6.4.9
Integration retrieves objects from the ISO outbox and deletes them from the ISO outbox.

6.4.10
Integration regenerates the CCOs (.fmb and .fmx for forms, and .rdf for reports only).

6.4.11
Integration writes the readme file.  The readme file may be for more than one TDR.  Generation will only occur once daily, or as required by the Test Manager, unless the TDR is priority 1.  Generation occurs immediately upon correction of a priority 1 TDR.  The readme file will contain the following information:

· Synopsis of each TDR 

· Match between CCOs and TDRs

6.4.12
Integration places all the objects and readme file into the ISO inbox.

6.4.13
Integration notifies Release Management by email that the objects are in the ISO inbox for the specific TDRs.

6.4.14
Release Management retrieves the objects from the ISO inbox and checks them back into PVCS.

6.4.15
Release Management creates the new DCII executable.

6.4.16
Release Management delivers the new DCII executable to the Test Manager and to OMD.

6.5
TDR Action for Functional Discrepancies
If the Suspected Origin of the TDR is Design and it has been determined during the TDR review that the problem is a difference between the functional requirement and the application design, the following steps identifies the action of the TDR:

6.5.1
DCII FUNCTIONAL PROPONENT GROUP (FPG) determines if design must be changed to implement requirement. DCII FPG documents the functional resolution of the TDR within the TDR Resolution field in CMIS, and routes TDR to the project development Action Manager.

6.5.2
Repeat steps in section 7.3, 7.4, or 7.5 as applicable.

6.6
TDR Action for Environment Discrepancies

If the Suspected Origin of the TDR is Environment, the following steps identifies the action of the TDR:

6.6.1
Project DBA takes action to correct environmental problem (example:  UNIX account permissions, Oracle shutdown, FICSbat process not running, etc.).

6.6.2
Project DBA documents resolution of the TDR within the TDR Resolution field in CMIS, and routes TDR to the test TAM.

6.7
TDR Action for System Integration Discrepancies
If the Suspected Origin of the TDR is System integration, the following steps identifies the action of the TDR:

6.7.1
Action is taken upon the TDR based upon analysis and resolution of integration problem.  TDR is routed from the Test TAM directly to DCII Integration team for resolution.

6.7.2
Systems Integration Action Manager documents resolution of the TDR within the TDR Resolution field in CMIS, and routes TDR to the test TAM.

7.
Print TDR
7.1
Printing a TDR
The following procedures describe the method for printing a TDR.

7.1.1
Highlight the TDR to be printed from within the TDR tab.

7.1.2
Select Print from toolbar or menu.  Print Options window displays.

7.1.3
Highlight System Testing Hardcopy Report, and press Print.  The Filter window displays.

[image: image20.png]AIS Selection and User, Assignments

Description

User Type

TORCOORD  DFAS CORPORATE DATABASE

CARVERL DFAS Corporate Warehouse.
TOR-CODRD  DFAS Corporate Warehause

'ACTING Techrical Action Manager
for TDR-COORD
Techrical Action Manager

ACTING Techrical Action Manager
for TDR-CODRD.





Image of Word (copy of TDRPROCS) screen open with CMIS - DCD (Technical Action Manager) open on top of it, System Testing window open on top of that, and the Print Options window open on top.

7.1.4
Select filter options as applicable.  Select OK.
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Image of Word (copy of TDRPROCS) screen open with CMIS - DCD (Technical Action Manager) open on top of it, System Testing window open on top of that, the Print Options window open on top of that, and the Filter window open on top.

8.
Convert TDR to SCR
8.1
Convert TDR to SCR 
Project management may elect to convert a Priority 3, 4 or 5 TDR to a SCR for a future release. This action is normally decided during the TDR review prior to the TDR being routed for resolution.  If the problem is not severe enough to warrant making changes to software that otherwise is stable, or there is a workaround to the problem, the TDR may be deferred to an SCR.

8.1.1
Select TDR in Test Director. Select Defect Details and select Details Tab. AT the bottom of the description describe action being taken. I.E. This TDR is being converted to an SCR and is to be forwarded to DCII TPO for analysis, impact and approval.

8.1.2
Highlight and copy your comments.
8.1.3
Highlight TDR in CMIS. Click on Configure button. Within the screen displaying the configured TDR select the Closure button.
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Image of Internet Explorer screen (Mercury TestDirector 7.6 SP3) open with CMIS - DCD (Technical Action Manager) open on top of it, and the Configure System TDR window open on top.

8.1.4
System testing TDR closure screen is displayed. Select the closure type drop down LOV and select “Convert to SCR”.
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Image of Internet Explorer screen (Mercury TestDirector 7.6 SP3) open with CMIS - DCD (Technical Action Manager) open on top of it, the Configure System TDR window open on top of that, and the System Testing TDR Closure window open on top.
8.1.5
A pop up box will be displayed for “System Testing TDR conversion options”. Select “Create New SCR” radio button. Click OK.
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Image of Internet Explorer screen (Mercury TestDirector 7.6 SP3) open with CMIS - DCD (Technical Action Manager) open on top of it, the Configure System TDR window open on top of that, the System Testing TDR Closure window open on top of that, and the System Testing TDR Conversion Options box open on top.
8.1.6
The “SCR Title, SCR Category, SCR Sub System” pop up box will appear. Add the SCR Title, select a category and SCR Sub System. Click OK.

[image: image4.png]Mercury TestDirector 7.6 SP3 - Miciosoft Internet Explorer -&lxl
Configure System TDR F
System Testing TDR Closure [x]

Closue Typei [Corvert050n 7] Closure Date: [ 1073072003 01545 Actual i [Developmert 5]

SCR Tie. [DNDOCUNENTED 108 AESPONSIBLITY FENOVAL

SCR Categon: [T~ Techrical E SCR SubSystem: E
. 901 [T Techrical ystem: [DCD N

[FCR GEN o <

INTERFACE 5Y5 No
lccos

[FINAL RESOLLTION
ITDR retutned to TDR Coordinator 10/26/03 - Kathy 0'Conrr, The final resclution ill b to update the FDSRAM ta show the Dracle Fiole assaciated with
he Job Responsibity CSF_FDO_SECURITY_OFFICER, to be idented as Oracle Role "CSF_ FUNC_ DATA_OWNER'.

[10/10/03 - R Braham
[The Job Responsibilfiesin question an this TOR have na eference to any SCR in his release. There i a new effat n place,

Jbsing diiven by the Seciiy team, o clean up the D & RAM. It is my suggestion that the cleanup process be complted and a new SCR
Jbe created to synchionize the database with the cleaned up D & RAM. | am forwarding this TDF to secuiy forther action

Job Respansibity "CSF FLINC DATA DWNER" renamed to "FDO Securiy Dfficer” in th following tables:
esf_job_tesprsbly

esf_job_tesprsbly_hst

es_menu_resprsbly

Extemal ok | BEeort| Bimpot| | cancel Help

I = = =

Readt 7
I . bl P} =T J=T T g omTs = =T PO T ISR





Image of Internet Explorer screen (Mercury TestDirector 7.6 SP3) open with CMIS - DCD (Technical Action Manager) open on top of it, the Configure System TDR window open on top of that, and the System Testing TDR Closure window open on top.
8.1.7
System testing screen appears. Click view all and highlight your converted SCR. Click Configure button, click SCR button and click forward button..
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Image of Internet Explorer screen (Mercury TestDirector 7.6 SP3) open with CMIS - DCD (Technical Action Manager) open on top of it, and the System Change Request Part Two - X2674 - 00 window open on top.
8.1.8
A window will appear. In the notes box add statement “This TDR is being converted to an SCR and is to be forwarded to DCII TPO for analysis, impact and approval”. Click OK.
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Image of Internet Explorer screen (Mercury TestDirector 7.6 SP3) open with CMIS - DCD (Technical Action Manager) open on top of it, the System Change Request Part Two - X2674 - 00 window open on top of that, and the Forwarding For - SCR X2674 - 00 (Initial Entry) box open on top.
8.1.9
Click OK.
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Image of Internet Explorer screen (Mercury TestDirector 7.6 SP3) open with CMIS - DCD (Technical Action Manager) open on top of it, the System Change Request Part Two - X2674 - 00 window open on top of that, the Forwarding For - SCR X2674 - 00 (Initial Entry) box open on top of that, and the SCR Approval box on top.
8.1.10
Reopen the TDR in Test Director and document SCR number it was converted to in the description. 

8.1.11
Coordinate with the Test Director SA to change status of TDR in Test Director to Converted.
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